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NetVanta Unified Communications

These release notes highlight new functionality, enhancements, software and hardware dependencies, and
include upgrade instructions for the NetVanta Unified Communications product family. This document is to be
used in conjunction with product documentation and training for the preparation of new and existing software
installations and is intended for technical professionals who are providing support services for NetVanta Unified
Communications products.

For general product information please visit ADTRAN's website at http://www.adtran.com.

CAUTION: ltis strongly recommended that the contents of this document be reviewed before any
installation or upgrade, no matter how familiar the installer may be with the product, to ensure that
current installation and upgrade procedures are followed. These procedures may change from
release to release, including maintenance releases. Failure to follow the upgrade procedures in this
document may result in non-operational systems.

1 Summary of Changes

This section describes a summary of new functionality introduced in this NetVanta UC Server release, along with
issues resolved in each release and any release-specific actions that are required as part of upgrading. Each
maintenance release is identified separately. More detailed descriptions for major new functionality follow in
section 2, New Functionality Details. Internal tracking numbers are noted (e.g. [1234]).

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes
or product documentation for the respective releases.

Where functionality or issues resolved do not apply to products in the product family, the applicable products are
noted (e.g. ECS, BAS).

NOTE: Be sure to review all upgrade actions for all releases between your current release and the release you are
upgrading to. Sub-sections in the sections below identify required actions, including information about client
upgrades.

1.1 Release 4.5.0

CAUTION: THIS IS A CONTROLLED RELEASE.

Release 4.5.0 is a major release of NetVanta UC Server that introduces support for Click-to-Dial and the ADTRAN
NetVanta 7000 Series IP PBXs. Additional feature improvements and fixes are also included. Product downloads
have been reduced in size by not including product documentation, Microsoft .NET Framework redistributables or
Adobe Reader redistributable.

This release also introduces new product names and branding. See section 2.4, ADTRAN Product Rebranding for
more information.

1.12.12  New Functionality
The new functionality introduced in this release includes:

e Click-To-Dial for NetVanta Enterprise Communications Server and NetVanta Business Communications

System [8466] ECS, BCS

e Support for ADTRAN NetVanta 7000 Series IP PBXs [8492] UCS, BCS
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e Outbound dialing improvements [8415]
e Telephone terminal support for ADTRAN IP 706, 712" [8615] ECS, BAS

1.1.2 Issues Resolved

Tracking# Summary

8246 More than one Generic PBX (via Gateway) cannot easily be added.

8486 SIP telephone’s MWI may not turn off immediately after registration. |ECS, BAS

8512 MWI may not turn off when quickly reading a newly delivered message in Outlook.
8581 Cannot set password and have it take effect for Merlin Magix CTlI link after initial configuration.
8592 First Time Access Wizard always runs in NetVanta UC Client for IMAP users even though all IMAP

configuration values have been configured.

Note that all fixes included in 4.4.1, 4.4.2, and 4.4.3 are included in release 4.5.0. Please consult the release notes
for 4.4.3 for details on issues resolved in those releases.

1.1.3 Upgrade Requirements

Prior to upgrading an existing NetVanta UC Server system, be sure that the hardware platform and operating
system software meet the minimum requirements; otherwise, you will not be able to upgrade the software.
Ensure that both client and server requirements are met. See section 3.2, System Requirements for more
information.

Both client and server components now require Microsoft .NET Framework 3.5 SP1 to be installed on target
systems.

1.1.4 Client Upgrade Actions

Client software MUST be upgraded for all users of the NetVanta UC Server system. More information on client
deployment techniques, including automated deployment can be found in section 4.3, Installing or Upgrading
NetVanta UC Client Software.

1.1.5  Other Upgrade Actions

Any scripts using the OutDial.exe command line program MUST be updated to accommodate new command line
syntax. Run outDial -? to obtain usage information.

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade
phone configuration files. Any customizations to phone configuration files must be manually re-applied using the
information and backups made by the scripts. See section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x
Release for more information on this procedure.

RestartOverrides.cfg MUST be updated on the NetVanta UC Server to include updated settings provided in

RestartOverrides.cfg.original.

*In order for ADTRAN IP Phones to correctly display time in the local time zone, the phones must have their
phone configuration file templates modified according to the phone documentation. In particular the GmtOffset
parameter must be configured. Please refer to http://kb.adtran.com/article.asp?article=2254&p=2 for more
details.



http://kb.adtran.com/article.asp?article=2254&p=2

NetVanta Unified Communications

CAUTION: Backup procedures have changed from releases prior to 4.3.3. The SQL database
instance for NetVanta UC Server MUST be backed up to ensure proper recovery of failed systems.
For instructions on backup and restore procedures, refer to the Planning and Deployment Guide,
available online at http://kb.adtran.com/. Please adjust backup procedures accordingly. Failure to do
so may result in data loss or extended system outages in the case of hardware or software failures.

CAUTION: Due to fixes related to MWI behavioral inconsistencies introduced in release 4.3.1, when
a system is upgraded to 4.5.x from a release prior to 4.3.1, users's may experience a change in
behavior of the MWI if their preferences (or system-wide settings) for MWI behavior are not set as
they would prefer. Please ensure that system defaults are correctly set and that users are aware of
how to change their MWI preferences.

2 New Functionality Details

This section describes more significant portions of the new functionality introduced in this NetVanta UC Server
release.

Where functionality or issues resolved do not apply to products in the product family, the applicable products are
noted.

2.1 Click-to-Dial

Click-to-dial enables users of NetVanta Business Communications Systems and NetVanta Enterprise
Communications Server to initiate a call by clicking on a contact or an email message within Microsoft Outlook
2003 and Microsoft Outlook 2007.

NetVanta ucCompanion provides a system tray icon that enables the user to select an identity, enter a telephone
number for dialing, launch NetVanta UC Client, and configure NetVanta ucCompanion.

Contact systems supported:

e  Windows Active Directory

e Outlook 2003 and Outlook 2007 Personal Contacts. The user’s personal contacts will be matched against
each of the email recipients addressed in the email. If a match exists, the corresponding name and
telephone numbers will be presented for the user to select.

If Microsoft Outlook 2003 or 2007 is installed, a plug-in will be installed that allows the user to initiate a call on
their configured telephone from:

1. Outlook Contacts

2. Email message
e Right click on email message in email preview. (Outlook 2007 only)
e  Call button within an email message

2.2 Support for ADTRAN NetVanta 7000 Series IP PBX

The ADTRAN NetVanta 7100/7060 has been added to the list of communications systems that can be added to
NetVanta UC Server. Centralized messaging of NetVanta 7100/7060 PBXs is accomplished by adding multiple
instances of NetVanta communications systems. Centralized messaging also applies to any number of PBXs.

The NetVanta 7100/7060 integration also includes click-to-dial functionality.
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2.3 Outbound Dialing Enhancements

Outbound dialing has been enhanced to include better support for working with external applications. Notable
improvements include:

Unique reference number given to each instance of outbound dialing request.
Added time windows support (names time periods and time zone definitions) to ensure that outbound
dialing notifications only occur during specified time windows.

3. Added a prioritization parameter to higher priority scheduled outbound dialing notifications to be dialed
ahead of lower priority notifications.

For a complete list of parameters supported by the OutDial command line program, run outdial.exe /2 from
the command line.

2.4 ADTRAN Product Rebranding

Objectworld branding has been replaced with ADTRAN branding. UC Server product editions have been replaced
with distinct products. Refer to the table below for details.

Old Product Edition Name New Product Name

Standard Edition NetVanta Unified Communications Server when sold for use with a third-
party PBX.
NetVanta Business Communications System when bundled with
NetVanta 7100/7060.

SIP Edition NetVanta Enterprise Communications Server

CEBP Edition NetVanta Business Application Server

3 Installation Requirements

This section describes the environmental prerequisites required for the correct operation of NetVanta UC Server,
including operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes
any steps required prior to installing NetVanta UC Server software, including obtaining the license key.

3.1 Preserving Installation and Upgrade Media

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the
software may be reinstalled at a later date if necessary (for example, in the event of a hardware failure).

If the software was downloaded, please ensure that a separate copy of the installation media is made to CD or
DVD and this media is stored in a safe place so that the software may be reinstalled at a later date if necessary (for
example, in the event of a hardware failure). Do not store the downloaded media on the same physical disks as
the operational server as a single disk failure may cause this media to be permanently lost.

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place.
Support personal may require a copy of the installation media to reinstall software at a later date.
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CAUTION: Failure to preserve installed software release media properly may result in the inability
to rebuild a failed server at a later date. Copies of non-current software versions may not be readily
available from ADTRAN Technical Support or your reseller and thus delays may be incurred if this
media is not available to support technicians rebuilding failed servers.

3.2 System Requirements

3.2.12  Server Components

This section describes the required operating systems, hardware requirements and third-party integration
platforms for the server components of NetVanta UC Server. This applies to both upgrades and new installations.
If existing server hardware does not meet these requirements, it must be upgraded or migrated to new hardware
prior to upgrading to this release of NetVanta UC Server.

3.2.1.1  Operating Systems
The server components of NetVanta UC Server support the following Microsoft® Windows™ Operating Systems:

e  Microsoft® Windows™ Server 2008 R2 (x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.

e  Microsoft® Windows Small Business Server 2008 (x64)

The recommended deployment for optimal performance and reliability is to install NetVanta UC
Server on the additional Windows Server 2008 license that is part of the Premium Edition of
Windows Small Business Server 2008. NetVanta UC Server can also be installed on the Windows
Small Business Server 2008 platform with suitable hardware. See section 3.2.1.2, Hardware
Requirements, for more information.

e  Microsoft® Windows Essential Business Server 2008 (x86, x64)

NetVanta UC Server should be deployed on the additional Window Server 2008 license that is part of
the Premium Edition of Windows Essential Business Server. Do not install NetVanta UC Server on
the Security Server. It is not recommended to install NetVanta UC Server on either the Management
Server or the Messaging Server.

e  Microsoft® Windows™ Server 2008 (x86, x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.
e  Microsoft® Windows™ Server 2003 R2 SP1, SP2 (x86)
e  Microsoft® Windows™ Server 2003 SP1, SP2 (x86)
e Microsoft® Windows™ Small Business Server 2003 SP1 (x86)
e  Microsoft® Windows™ XP SP2, SP3 (Professional) (x86) (Warning: see known limitation [82821])

Other software platforms are not supported.

Installation of the server components into a virtualization environment (Virtual Server, Hyper-V, Virtual PC,
VMware, Virtual Box, etc.) is not supported in production deployments. This is due to the real-time nature of
telecommunications — audio problems will be experienced in these environments.

ADTRAN recommends using a server operating system for all installations of NetVanta UC Server. While the
client platforms mentioned above (such as Microsoft® Windows™ XP) are supported, they are designed by
Microsoft for desktop use not server use. Known limitation [8282] is also known to affect the reliability of
Windows XP installations and may cause system outages in certain circumstances. See section 7, Known Software
Limitations for more details.
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CAUTION: At this point in time, many third-party drivers and applications may not yet support
Windows Server 2008 and derived platforms (SBS 2008, EBS 2008). When using TAPI integrations,
or other integrations requiring use of CTl drivers, please review driver documentation for those
products BEFORE proceeding with plans to use Windows Server 2008 as the server platform for
those deployments.

3.2.1.2 Hardware Requirements

To install NetVanta UC Server, the server hardware platform must meet the minimum requirements in the table
below. The minimum requirements are for a minimal installation. The recommended requirements are a guideline
for more robust, reliable and “future-proofed” systems.

Product engineering guidelines and recommendations should be consulted and followed for anything other than a
minimal installation (i.e. installations with more than 25 users). Sizing of the server hardware is dependent on the
number of users, the traffic levels and application services used. Selection of hardware should also take into
account such things as redundant power supplies, uninterruptable power supplies (UPS) and redundant disk
arrays (i.e. RAID) such that the end-users needs and expectations are met, along with any future growth
requirements.

Consult TN202 - Hardware Platform Recommendations and the Planning and Deployment Guide, available online at
http://kb.adtran.com, for more information on correctly selecting the hardware.

Hardware Minimum Recommended
Component
Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310)
RAM 2GB 4 GB
4 GB on Windows Small Business Server 2003 6 GB on Windows Small Business Server 2008

6 GB on Windows Small Business Server 2008

Disk space 80 GB (usable space) 146 GB (usable space)
7200 RPM SAS - RAID 1 0r RAID 5

3.2.2  Mail/Messaging Servers for Unified Messaging
NetVanta UC Server supports the following email servers for Unified Messaging:

e  Microsoft® Exchange™ Server 2000, 2003 SP1 (requires service pack 1 or later), 2007

e [IBM®Domino™ Server 6.0.%, 6.5.%, 7.0, 8.0 (via IMAP)

e Google Mail (via IMAP using stunnel)

e  University of Washington IMAPd

e Any 100 percent compliant IMAP4revi (RFC3501) message store (different servers may require different
query optimization techniques — consult product documentation for query optimization technique
determination procedures)

Integration with Microsoft® Exchange™ Server requires a MAPI connector to be installed on the NetVanta UC
Server platform. The supported MAPI connectors, of which only one should be installed on the server platform,
are the following:

e  Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1
(Version: 6.5.8069.0, 2009-Feb-16 — older versions are not be compatible with all platforms)
This is available for download free of charge from:
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http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-
0a110307611e&displaylang=en
e  Microsoft® Outlook™ 2003 SP3

CAUTION: Failure to use SP3 with Microsoft® Outlook™ 2003 will cause unreliability of the
integration with Microsoft® Exchange™ Server and may cause system outages.

e  Microsoft® Outlook™ 2007 SP1 (SP2 is not supported)

CAUTION: Outlook 2007 SP2 (recently released) is not compatible as a server MAPI connector with
UC Server and installing it will cause NetVanta UC Server to be unable to connect to Exchange
Server.

ADTRAN recommends using Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 instead
of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead of Outlook.
The benefits of doing this are as follows:

e No Outlook license is required for the NetVanta UC Server system. The MAPI/CDO package is available
at no charge.

e The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates.

e This component is designed and provided by Microsoft explicitly for the purpose of allowing applications
such as NetVanta UC Server to access Exchange Server and does not include many of the client-side
nuances of Outlook versions of MAPI.

On Exchange Server 2003, additional steps are required after following the manual integration instructions in
Appendix A of the Server Configuration Guide:

Delegate “Exchange View Only Administrators” control to the NetVanta UC Server service account:

1.

w N

N oon s

8.
9.

10.
11.

Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation.
Select the enterprise level object (the root object in the tree).

Select Delegate control... from the Action menu. This will open the Exchange Administration Delegation
Wizard.

Click Next.

In the Users or Groups page of the wizard, click Add to open the Delegate Control dialog box.

Select the role Exchange View Only Administrators from the list of roles.

Click Browse... and select the service account used by NetVanta UC Server for Exchange Server and network
integration.

Click OK in the Select Users, Computers or Groups dialog box.

Click OK in the Delegate Control dialog box.

Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard.

Click Finish to complete and close the wizard.

3.2.3 Client Components

This section describes the required operating systems and hardware requirements for the client components of

NetVanta UC Server. Most installations will deploy client software to some or all of the end users of the system.

Some installations do not require deployment of the client software depending on how NetVanta UC Server will

be used.
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3.2.3.1  Operating Systems
The client components of NetVanta UC Server (NetVanta UC Client, NetVanta ucCompanion and NetVanta
ucCompanion - Live Attendant) support the following Microsoft® Windows™ Operating Systems:

e Microsoft® Windows™ 7 (Professional, Ultimate, or Enterprise Editions) (x86, x64)

e  Microsoft® Windows™ Vista, SP1, SP2 (Business, Ultimate, or Enterprise Editions) (x86, x64)
e  Microsoft® Windows™ XP SP2, SP3 (Professional or Tablet PC Editions) (x86)

e Microsoft® Windows™ Server 2008 R2 (x64)

e  Microsoft® Windows™ Server 2008 (x86, x64)

e  Microsoft® Windows™ Server 2003 R2, SP2 (x86)

e  Microsoft® Windows™ Server 2003 SP1, SP2 (x86)

Other software platforms are not supported.

3.2.3.2  Prerequisite Components
Client components now require Microsoft .NET Framework 3.5 SP1 to be installed on target systems. In addition,
for some components additional Microsoft redistributable components will be installed by the client installer.

3.2.3.3 Hardware Requirements
To install NetVanta UC client, the platform must meet the following minimum requirements for the specified
Microsoft Windows operating systems listed below.

Client XP, Server 2003 Vista, Windows 7, Server 2008,
Server 2008 R2

Processor x86 compatible processor x86 or x64 compatible processor
600 MHz or higher 1GHz

RAM 256 MB 1GB

Free Disk space 5oo MB 5oo MB

Video Super VGA (800 x 600) or higher- Support for DirectX g graphics with:
resolution video adapter and monitor e \WDDM Driver

e Minimum 128 MB graphics
memory
e Pixel Shader 2.0 in hardware

e 32 bits per pixel

3.2.3.4 Email Clients for Unified Messaging
NetVanta UC Client integrates with the following email clients for Unified Messaging:

e  Microsoft® Outlook™ 2000, 2002/XP, 2003 SP3, 2007
e |IBM® Lotus Notes™ 6.0x, 6.5.%, 7.0, 8.0
3.3 Product Licensing (License Key)

All NetVanta UC Server products must be correctly licensed to operate. The license key obtained from ADTRAN is
specific to each installation and defines the exact functionality licensed by the end-user for their installation.
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3.3.1  New Installs

When installing NetVanta UC Server for the first time, you must obtain a License Key to install and activate the
software.

3.3.2 Upgrades

To upgrade NetVanta UC Server from a previous major or minor release, you must obtain a new License Key prior
to starting the upgrade. The existing License Key, found in the License Information dialog box in the
administrative NetVanta UC Client must be updated to the new License Key prior to starting the upgrade. After
the new key is installed, you may continue to upgrade the server software. You do not need a new license key for
maintenance (patch or dot) releases.

Upgrade license keys are only available to customers who have an active Software Assurance subscription.

3.3.3 Obtaining a New License Key

To obtain a new or upgrade license key, fill out a license key request in the UC Tools area of the ADTRAN website
(http://www.adtran.com/uctools).

Note: Please allow enough time to obtain the license key — at least one (1) business day should be allocated to
ensure the license key is obtained before installation or upgrade.

You will need the following information:

a. Contact information
b. Product Keys
¢ New installs: available from materials that shipped with the product.
e Upgrades: available for a user with Administrator privileges. From NetVanta UC Client select the
Help menu > License Information.
c. Purchase Key
¢ New installs: available from materials that shipped with the product.
e Upgrades — available:
e  Forauser with Administration privileges. From within NetVanta UC Client select the Help
menu > License Information. Click Modify license.
e Viathe Product Licensing Wizard dialog box of step 1 of NetVanta UC Server
Configuration Wizard
d. MachineID
¢ New installs: available within the Product Licensing Wizard dialog box of step 1 of the NetVanta
UC Server Configuration Wizard
e Upgrades — available:
e  Forauser with Administration privileges. From within NetVanta UC Client select the Help
menu > License Information. Click Modify license.
e Viathe Product Licensing Wizard dialog box of step 1 of NetVanta UC Server
Configuration Wizard
e. Platform specifications: CPU speed, RAM and Server OS — available from the System control panel in
the Windows Control Panel.
f.  Product version and edition you will be installing or upgrading to — available from the materials
shipped with the product
g. Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and
version
h. Legacy PBXinterconnection, if applicable: PBX Type, Firmware version
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3.4 Prerequisite Components

NetVanta UC Server requires that prerequisite components be installed prior to installation of NetVanta UC
Server software. The installer will detect which components are missing from the system and prompt accordingly.
Some of the prerequisite components are included on the distribution media and can be installed automatically
by the installer. However, others must be obtained directly from the vendor. Links to the relevant web-sites for
any components that need downloading will be provided by the installer.

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the
prerequisites are installed automatically by the installer. The prerequisite components are:

e Microsoft Windows Server 2003 Service Pack 1 Administration Tools Pack (download link provided in
installer) [Windows XP only]

e Microsoft .NET Framework 3.5 SP1 (download link provided in installer)

e Visual Studio 2005 SP1 Redistributable Files

e ADTRAN Software Logging Diagnostic Tools

e Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows
Server 2008-based systems only]

e Microsoft SQL Server 2005 Express Edition (SP3 version is installed, older service packs are supported
except on some OS platforms)

CAUTION: NetVanta UC Server will only work correctly with the version of Microsoft SQL Server
that is provided on the distribution media. Other instances of SQL Server cannot be used by
NetVanta UC Server.

4 Installation and Upgrade Instructions

Please review section 3, Installation Requirements, before proceeding with this section. It contains important
information about product licensing, system requirements, and the versions of required external software
components.

CAUTION: Failure to comply with the installation requirements, or properly follow the installation
or upgrade instructions will result in an inoperable or poorly performing system.

4.1 New Install of NetVanta UC Server

This section contains an overview of the installation for NetVanta UC Server; for detailed installation procedures
consult the Installation Guide applicable to your NetVanta Unified Communications product. To facilitate
installation and configuration, have the following reference material available during installation:

e Release Notes (this document)

e Planning and Deployment Guide

e Installation Guide

e NetVanta Unified Communications Server Presence and Control Components Guide (for use with NetVanta
ucCompanion - Live Attendant)

e  Configuration Guide

e Administrator Guide

To ensure that all the required information is available during the installation and configuration process, it is
recommended that the Planning and Deployment Guide Worksheet be completed.
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4.1.1 Installing the Server Software

The installation software will automatically verify the prerequisites for software installation. Make sure that you
run the installation from a Windows logon that has the ability to install software on the NetVanta UC Server
system (i.e. Administrator privileges).

To install NetVanta UC Server:

1. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website follow step (a), if the
NetVanta UC Server CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on NetVanta UC Server (you
will need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear).

b. Insertthe NetVanta UC Server CD-ROM - the Auto run application will start and the ADTRAN
NetVanta Unified Communications CD Menu will appear.

2. Install the applications to the NetVanta UC Server platform by clicking on the Install Server button on the
installation screen and following the prompts on the subsequent screens.

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the
components purchased, such as the Presence and Control components and the Windows 2003
Server Administration Tool Pack. The NetVanta UC Server Installation Wizard will ensure that all
prerequisite components are installed before proceeding.

b. After all the prerequisite components are successfully installed, the wizard allows you to install the
NetVanta UC Server software.

3. Runthe NetVanta UC Server Configuration Wizard, Configure UC Server. The NetVanta UC Server
Configuration Wizard allows you to specify server properties such as message store, NetVanta UC Server
administrator password, PBX information, and dialing properties. The wizard guides you through the server
configuration process. The wizard does most of the configuration tasks automatically, however, site specific
information about the network and server needs to be entered at various steps.

4. When installing NetVanta UC Server for the first time, you must obtain a License Key. To obtain a license
key, please refer to section 3.3, Product Licensing (License Key).

4.1.2  Installing the Client Software

In order for users of NetVanta UC Server to take full advantage of its functionality, client software should be
deployed to their desktop or laptop computers. See section 4.3, Installing or Upgrading NetVanta UC Client
Software , for installation options and procedures.

4.2 Upgrading/Cross-grading of NetVanta UC Server

CAUTION: Backup procedures have changed from previous releases. For instructions on backup
and restore procedures, refer to the Planning and Delpoyment Guide, available online at
http://kb.adtran.com, and adjust backup procedures accordingly. Failure to do so may result in data
loss or extended system outages in the case of hardware or software failures.

4.2.1  Upgrade/Cross-grade Matrix

The following table describes which versions of NetVanta UC Server are upgradable to newer versions and which
versions of CallAttendant Office are cross-gradable to NetVanta UC Server.

To 4.0.X 4.5.X
(UC Server) (NetVanta UC Server)



http://kb.adtran.com/

NetVanta Unified Communications

From
Pre 3.2.x (CallAttendant Office) unsupported via direct upgrade | unsupported via direct upgrade —
— upgrade to 3.2.x first, then to upgrade to 3.2.x first, then to
4.0.X 4.0.X
3.2.x (CallAttendant Office) J unsupported via direct u_pgrade -
upgrade to 4.0.x first
4.0.x (CallAttendant Office) v v
4.2.x (CallAttendant Office)
4.0.x (UC Server) v
4.1.x (UC Server) Vv
4.2.X (UC Server) v
4.3.x (UC Server) Vv
4.4.X (UC Server) v
4.5.X (NetVanta UC Server) v

In order to upgrade from older versions, interim upgrade steps must be followed. Refer to the applicable section
below for more details.

4.2.2  Upgrading NetVanta UC Server from any 4.x.x Release

CAUTION: The existing version of NetVanta UC Server must NOT be un-installed prior to
upgrading. The installation process requires that the existing implementation be available in order
to perform the upgrade correctly.

The following is a summary of the upgrade procedure from any NetVanta UC Server 4.x.x release; refer to the
Installation Guide applicable to your NetVanta Unified Communications product, available online at
http://kb.adtran.com, for detailed instructions on installing this component.

CAUTION: Failure to follow the steps below, exactly as described, may result in a system that does
not upgrade or operate correctly after upgrade.

Perform the following steps:

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in
section 3.3, Product Licensing (License Key).

2. Backup the NetVanta UC Server. For instructions on backup and restore procedures, refer to the Planning
and Deployment Guide applicable to your NetVanta Unified Communications product, available online at
http://kb.adtran.com/. This will preserve the following data:

a) Users (greetings, services, announcements)
b) Port configuration

c¢) Attendant data

d) System configuration

e) Routing data

f) Telephone data



http://kb.adtran.com/
http://kb.adtran.com/

NetVanta Unified Communications

g) Gateway data
h) PBX configuration data

CAUTION: Failure to backup the data as per the instructions above and in the Technical Note will
result in the inability to restore the system to the original system configuration should the upgrade
process be unsuccessful or aborted. Always backup the system prior to upgrading.

3. Ifanewlicense key was obtained in step 1, modify the current license key using the following procedure:
a) Open NetVanta UC Client using the current installed product version and log in as a user with
administrative privileges.

b) Select License Information... under the Help Menu on the main toolbar.

c) Click the Modify license... button to open the Modify License dialog box.

d) Enterthe new license key in the space provided.

e) Click OK to close the Modify License Dialog box.

f)  Click Close to close the License Information Dialog box.

g) Close NetVanta UC Client by clicking the top right corner x icon or selecting Close from the File

menu.
4. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website follow step (a), if the

NetVanta UC Server CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you
will need to provide a location and name for the folder).

b. Insertthe NetVanta UC Server CD-ROM. The CAAutoRun application will start and the ADTRAN
NetVanta Unified Communications CD Menu will appear — leave this open for now, you will use it
later.

5. For ECS and BAS product variants, run the Pre-Update.bat script file as follows:
a) Click the Start menu and select Run...
b) Type cmd.exe and click OK to open a command prompt window
c) Navigate to the script folder on the installation media using the D command. This is located in
the Utility\Scripts subfolder of the installation media.

e.g.:CD /d C:\NetVantaUCServerInstallMedia\Utility\Scripts

d) Runthe Pre-Update.bat script, supplying any appropriate parameters relevant to your
installation:

Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e Ifyour NetVanta UC Server installation is not located at C: \Program
Files\ADTRAN\NetVanta UC Server), you must specify the location of
the PhoneTypes system data folder as shown in the example below.

e If backups should be written to a location other than
C:\Backup\PhoneTypes, then you must specify a backup folder as shown in
the example below.

e The /2 Option provides help on the script; the /v option provides more
detailed output and logging.

e.g.: Pre-Update.bat “C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\” “C:\Backup\PhoneTypes\”

e) When the script prompts to continue, confirm the information displayed, and type Y, then press
Enter.

f)  Examine the output of the script to ensure it ran correctly. The output is placed a file called
Pre-Log. txt in the backup location, which defaults to C: \Backup\PhoneTypes.
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g) Leavethe command window open as it will be used later
The ADTRAN NetVanta UC Server Application Services service could be unable to be started during the
upgrade due expiry of the service account password. This can also occur spontaneously on some
Windows XP installations or in networks where account passwords have to be changed regularly, but will
not be detected until the machine is restarted or the ADTRAN NetVanta UC Server Application Services
service is restarted. Be sure to have the service account password accessible in order to reset it
immediately.
To verify that the service account password has not expired, do the following:
a) Open the Services administration tool from Start > Control Panel > Administrative Tools.
b) Locate the service named ADTRAN NetVanta UC Server Application Services.
c) Rightclick on the service, and select Restart from the context menu.
d) If the service fails to start, right click on the service, and select Properties from the content
menu.
e) Selectthe Log On tab. Re-enter the service account password in the provided fields and click
OK.
f)  Attempt to start the service again by right-clicking on the service, and selecting Start from the
context menu. If the service again fails to start, verify that the service account is operating
correctly and is not locked out.

Failure to perform this step will cause the install to fail with a 1920 error if there is a problem with the
service account or its password. This can be corrected by following the same steps while the 1920 error is
displayed. Do not cancel the 1920 error dialog box because it will fail to upgrade and your system will
have to be restored from backups. When you have corrected the service account password, click Retry in
the 1920 error dialog box.

If the NetVanta UC Server software was downloaded from the ADTRAN website follow step (a), if the

NetVanta UC Server CD-ROM was shipped to you, go to step (b)

c. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by
double clicking on CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will
appear).

d. From the ADTRAN NetVanta Unified Communications CD Menu (opened when the CD was inserted
in a previous step), click the Install Server button to prepare the NetVanta UC Server upgrade.

On an upgrade from previous releases, you may be required to install or update prerequisite

components. Click on the Verify or automatically install remaining components button to proceed.

Some components may need to be downloaded from the vendor’s websites.

Adding the NetVanta UC Server Presence and Control Components:

a) If youare using the NetVanta Unified Communications Server product variant, or if you do not
plan on using NetVanta ucCompanion - Live Attendant:
e Disable the following option: Install Presence Components.
e  Click Next.
b) If you are upgrading the Presence and Control Components from a 4.2.X, 4.3.X, 4.4.X OF 4.5.X
version:
e C(lick the Install Presence Components button in the Preparing UC Server Installation
dialog box.
e  C(lick Install on the Resuming the Objectworld UC Server Presence and Control
Components Setup Wizard screen.
e  Click Finish when complete.
e Click Yes when prompted to restart the system for the configuration changes to take effect.
c) Ifyou are upgrading the NetVanta UC Server Presence and Control Components from a 4.1 Trial
version:
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e C(lick the Install Presence Components button in the Preparing UC Server Installation
dialog box.

e Click Next on the welcome page of the ADTRAN UC Server Presence and Control
Components Setup wizard and follow the prompts on subsequent screens until finished.
Consult the NetVanta Unified Communications Server Presence and Control Components
Guide for additional installation documentation.

10. Upgrading the NetVanta UC Server.
a) Ifupgrading from 4.2.X, 4.3.X, 4.4.X OF 4.5.X:

e The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear
briefly as the upgrade does various checks on the system.

e C(lick the Install button when the page titled Resuming the ADTRAN NetVanta Unified
Communications Server Setup Wizard appears and follow the prompts to complete the
upgrade.

e  Click the Finish button to close the setup wizard and return to the Preparing NetVanta UC
Server Installation dialog box.

b) If upgrading from 4.0.x or 4.1.x Trial:

e Install the server application to the NetVanta UC Server platform by clicking on the Install
UC Server button.

e  The ADTRAN NetVanta Unified Communications Server Setup welcome page will
appear briefly as the upgrade does various system checks.

e  Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified
Communications Server Setup Wizard appears.

3 Continue clicking the prompts to complete the upgrade.

e  Click the Finish button to return to the Preparing UC Server Installation dialog box.

11. Click the Configure UC Server button to launch the NetVanta UC Server Configuration Wizard.

NOTE: If all the steps in the server configuration were completed prior to the upgrade, you will be presented
with three options (Change Service Account, Add Users, and Specify Phone Types). You may be required
to perform the first option, Change Service Account to reset the service account to what had previously
been configured prior to the upgrade.

12. Inan upgrade from 4.0.x you need to complete Gateway configuration in the NetVanta UC Server
Configuration Wizard then reset the service account:
a) Click onthe Configure UC Server to launch the NetVanta UC Server Configuration Wizard.
b) When prompted to login, login as a user with NetVanta UC Server administrative privileges.
c¢) Complete the Gateways portion of the wizard. (Select Next, select None then Next, then click
Finish to close the Gateway wizard).
d) Click Exit to close the NetVanta UC Server Configuration Wizard.
e) Click the Configure UC Server button in the Preparing UC Server Installation dialog box.
f)  Login as a user with NetVanta UC Server administrative privileges when prompted.
g) Click onthe Change Service Account option and proceed to configure the service account.
h) Select the service account that was configured prior to the upgrade.
i) Click Close to exit the NetVanta UC Server Configuration Wizard.
j)  Click Close to exit the Preparing UC Server Installation.
13. For ECS and BAS product variants, run the Post-Update.bat script file as follows:
a) Locate the command window opened in step 5
b) Runthe Post-Update.bat script, supplying any appropriate parameters relevant to your
installation:

Syntax: Post-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]
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e If your UC Server installation is not located at C: \Program
Files\ADTRAN\NetVanta UC Server)\, you must specify the location of
the PhoneTypes system data folder as shown below in the example.

e If backups were written to a location other than C: \Backup\PhoneTypes,
then you must specify the same backup folder as specified in step 5.

e The /2 Option provides help on the script; the /v option provides more
detailed output and logging.

e.g.: Post-Update.bat “C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\” “C:\Backup\PhoneTypes\”

c) When the script prompts to continue, confirm the information displayed, and type Y, then press
Enter.

d) Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Post-Log.txt in the backup location, which defaults to ¢: \Backup\PhoneTypes.

e) When the script completes, it will indicate if any site-specific customizations have been made.
Details of the customizations will be output to a file called FileComparison. txt in the backup
location, which defaults to C: \Backup\PhoneTypes.

f)  Re-apply site-specific customizations to the relevant phone configuration files. Refer to phone
vendor documentation if needed. Once any customizations have been re-applied, restart the
ADTRAN NetVanta UC Server Application Services service using the Services administrative
tool.

14. Update the RestartOverrides.cfg file (located in ..\NetVanta UC Server\Data\System\Recovery\)
according to the following conditions:

a. If manual changes have been made to this file, then you must manually copy any entries from
RestartOverrides.cfg.original to RestartOverrides.cfgthat are not presentin the latter
file.

b. If no manual changes have been made to this file, then replace the contents of
RestartOverrides.cfg with the contents of RestartOverrides.cfg.original. Itis not
necessary to restart the ADTRAN NetVanta UC Server Application Services service. However, if the
file has been appended to instead of being replaced then the Application service must be restarted
for the changes to take effect.

15. If "Install Presence Components" was selected in step g, you will be required to configure these
components at this time. Please consult the NetVanta Unified Communications Server Presence and
Control Components Guide for configuration documentation. If this is an upgrade from 4.2.X, 4.3.X, 4.4.X
or 4.5.%, then the NetVanta UC Server Presence and Control Components may have already been
configured.

16. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions,
please see section 3.7, Configuring Services, of the Installation Guide.

17. For ECS and BAS product variants, re-apply phone configurations to all phones in the system as follows:

a) Open NetVanta UC Client and log in as a user with administrative privileges.

b) Click onthe Administration navigation bar.

c) Click onthe Phones folder in the Administration navigation bar.

d) Inthe contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-
End on the keyboard. All phones should now be selected.

e) Right-click on one of the selected phones, and select Reload Configuration from the menu. This
will cause all phone configuration files to be regenerated and phones to reload their
configuration data (rebooting most phone types).




NetVanta Unified Communications

4.2.3  Cross-grading from CallAttendant Office Server 4.0.x/4.2.x to NetVanta UC Server

CAUTION: The existing version of CallAttendant Office must NOT be uninstalled prior to cross-
grading. The installation process requires that the existing implementation be available in order to
perform the upgrade correctly.

The following is a summary of the procedure for cross-grading your CallAttendant Office release 4.0.x/4.2.x

software, please consult the Installation Guide for detailed instructions on installing the NetVanta UC Server
component. If the CallAttendant Office software is currently below the 4.0 Software versions, you must first
upgrade to Release 4.0.x version.

This upgrade will take significantly longer as the NetVanta UC Server installation program will make a complete
copy of the data for the upgraded installation. For large installations where voice and fax messages are stored on
locally, it can take 1-2 hours to copy the data during the upgrade. Do not cancel the upgrade during this process.
As a result, this upgrade will require at least twice as much disk space as the Data folder occupies in order to
perform the upgrade.

Prior to upgrading to release 4.0.x do the following:

1. Backup the CallAttendant Office using the instructions found in TNoy1 — Backup and Restore Procedures
for CallAttendant Office , available online at http://kb.adtran.com, to preserve the following data:

a. Users (greetings, services, d. System configuration
announcements) e. Routing data

b. Port configuration f. Telephone data
Attendant data g. Gateway data

CAUTION: Failure to backup the data as per the instructions above and in the technical note will
result in the inability to restore the system to the original system configuration should the upgrade
process be unsuccessful or aborted. ALWAYS backup the system prior to upgrading.

2. Record the CallAttendant Office service account username and password. This can be done using the
Services Control Panel application. Select the CallAttendant Office service and record the username. The
password must already be known as it cannot be viewed in the Services Control Panel.

3. You must have an up-to-date license key to support the latest release of CallAttendant Office 4.0.x and
NetVanta UC Server (in some circumstances, you may receive two (2) license keys that will be used to
support the upgrade). To obtain a new license key, please refer section 3.3.3, Obtaining a New License
Key.

4. Ensure that you enter the new license key in the CallAttendant Office administrator application (Help >
License Information) menu prior to upgrading the software.

CAUTION: If an existing PBX is being replaced with NetVanta Enterprise Communications Server,
please contact support@adtran.com for additional instructions.

To install NetVanta UC Server:

1. Rename all of the configuration files in the . \Data\System by appending . 014" to the existing
filename:

e.g.C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old
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If the NetVanta UC Server software was downloaded from the ADTRAN website follow step (a), if the

NetVanta UC Server CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you
will need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. See section 3.1, Preserving Installation and Upgrade
Media.

b. Insertthe NetVanta UC Server CD-ROM - the Auto run application will start and the ADTRAN
NetVanta Unified Communications CD Menu will appear.

If you plan on using NetVanta ucCompanion — Live Attendant, install or update the NetVanta UC Server

Presence and Control components at this time. Consult the NetVanta UC Server Presence and Control

Components Guide for installation documentation, which is provided on the distribution media.

Install the server applications to the NetVanta UC Server platform by clicking on the Install UC Server

buttons on the NetVanta UC Server installation screen and following the prompts on the subsequent

screens until finished.

For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions,

please see section 3.7, Configuring Services, of the Installation Guide.

Once the installation has completed, select the Configure UC Server button to run the Server

Configuration Wizard but do not add anything if it has already been configured. From the set of options,

at a minimum, complete the following tasks:

a. Enterthe NetVanta UC Server License key to enable SIP functionality

b. Configure the Windows Network Integration and select from one of the following:

i. If the service account was previously configured for Local System account, you must create a
Windows account on the local machine. Operating the Application Services service on the
Local System account is no longer supported.

ii. If the service account was previously configured with a Windows Active Directory™ account,
then configure the Existing Service Account.

Open the Windows Services application and ensure that the ADTRAN NetVanta UC Server

Application Services service is set to start automatically. Note, you may have to refresh (Fs) the Services

application in order to get a current view of the status. From the Windows Services applications, start

the ADTRAN NetVanta UC Server Application Services service if it is not already started.

Complete the remaining steps in the NetVanta UC Server Configuration Wizard. If appropriate add any

additional configuration changes required such as adding NetVanta Enterprise Communications Server

as a new communication system, adding new phone types or new gateways.

Cross-grading from CallAttendant Office Server 3.2.x to NetVanta UC Server (all editions)

NOTE: It is not possible to upgrade directly from 3.x to 4.2 and later releases (see section 4.2.1, Upgrade/Cross-
grade Matrix). An upgrade from CallAttendant Office 3.x to CallAttendant Office 4.0.x must be performed as an
intermediate step. Once this is completed, an upgrade to the latest NetVanta UC Server 4.x release can be

completed.

To upgrade 3.x to 4.0.x:

1.

Backup the CallAttendant Office using the instructions found in TNoy1 — Backup and Restore Procedures
for CallAttendant Office, available online at http://kb.adtran.com, to preserve the following data:

a. Users (greetings, services, d. System configuration
announcements) e. Routing data

b. Port configuration f. Telephone data
Attendant data g. Gateway data
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CAUTION: Failure to backup the data as per the instructions above and in the technical note will
result in the inability to restore the system to the original system configuration should the upgrade
process be unsuccessful or aborted. ALWAYS backup the system prior to upgrading.

2. Stop the CallAttendant Office Service from the Windows Services application.

3. Rename the following files:

a. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\Announcements folder to Announcements.old

b. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

4. Ifthe CallAttendant Office software was downloaded from the ADTRAN website follow step (a), if the
CallAttendant Office CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on the CallAttendant Office
server (you can create a CallAttendant Office folder). Start the installation by double clicking on
CAAutoRun.exe (the CallAttendant Office installation screen will appear). Preserve a copy of the
installation media accordingly. See section 3.1, Preserving Installation and Upgrade Media.

b. Insert the CallAttendant Office CD-ROM - the Auto run application will start and the CallAttendant
Office installation screen will appear.

5. Install the Server applications to the CallAttendant Office platform by clicking on the Install
CallAttendant Office Server buttons on the CallAttendant Office installation screen and following the
prompts on the subsequent screens until finished. Do not choose to reboot the computer at this point.

6. Openthe Windows Services application and set the CallAttendant Office Service to start
automatically.

NOTE: You may have to refresh (Fs) the Services application in order to get a current view of the status.

7. From the Windows Services applications, start the CallAttendant Office service.

8. Convert the system audio. If the software was upgraded from Release 3.1 or earlier, you must convert
the audio from the pre-existing 11 kHz-8bit audio format to the newly supported 8 kHz mu-law audio.
Although the CallAttendant Office server will change the audio format “on-the-fly” the conversion will
introduce latency in playing audio files or messages.

CAUTION: Ensure that you perform this conversion during the maintenance window — typically
after normal business hours.

To perform the audio conversion:

a. From My Computer, navigate to the C:\Program Files\Objectworld\CallAttendant
Office Server\Bin directory
b. Double-click onthe Convertaudio.exe application.

4.2.5 Upgrading Client Software

If anything other than a minor server upgrade has taken place, client software must be updated on end user
computers; only 4.5.x client software is supported with 4.5.x server software. See section 4.3, Installing or
Upgrading NetVanta UC Client Software, for installation options and procedures.
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4.3 Installing or Upgrading NetVanta UC Client Software

This section documents manual installation procedures, and presents other techniques for automated client
deployment.

CAUTION: Only release 4.5.x NetVanta UC Client software is compatible with NetVanta UC Server
4.5.x software (the patch revision value 'x’ does not need to be identical). All incompatible clients
must be upgraded after the NetVanta UC Server has been upgraded.

4.3.1  Manvual Installation or Upgrade Instructions

NOTE: The user installing NetVanta UC Client software MUST have administrative privileges on that desktop
computer.

1. If the NetVanta UC Server software was downloaded from the ADTRAN website follow step (a), if a NetVanta
UC Server CD-ROM was shipped to you, go to step (b)

a. Unzip the contents of the file you downloaded to a temporary folder on the desktop computer (you
will need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. See section 3.1, Preserving Installation and Upgrade
Media.

b. Insertthe NetVanta UC Server CD-ROM - the Auto run application will start and the ADTRAN
NetVanta Unified Communications CD Menu will appear.

2. Install the client applications to the client computer by clicking on the Install Client button on the installation
screen and following the prompts on the subsequent screens.

CAUTION: Installing NetVanta UC Client directly on the NetVanta UC Server platform is not
supported. Ensure that the client is installed on a separate platform meeting the minimum
requirements

4.3.2  Other Techniques for Installing and Upgrading Client Software
Client software may be deployed using automated techniques including:

e GPO-based MSlinstallation. See TNo34 - Client Software Installation Guide, available online at
http://kb.adtran.com, for more information on this option.

e GPO-based login scripts that invoke either SETUP . EXE or MSIEXEC . EXE with appropriate parameters.
Prerequisites components need to have been previously installed successfully. Consult standard
Microsoft documentation for more information on those techniques.

5 Support, Documentation and Training

5.1 Support

Self-service support material can be obtained from the ADTRAN website, http://www.adtran.com/support/, and
from the ADTRAN Technical Support Knowledge Base, http://kb.adtran.com/.

Information on product support services can be obtained from the ADTRAN website:
http://www.adtran.com/support/.
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5.2 Documentation

Product documentation and additional technical support material can be found on the ADTRAN website,
http://www.adtran.com/support/, and in the ADTRAN Technical Support Knowledge Base, http://kb.adtran.com/.

5.3 Training

Information on current training programs and certifications can be found on the ADTRAN website:
http://www.adtran.com/training/.

5.4 Product Downloads and Third-Party Drivers

Product downloads and third-party drivers and patches are available in the support area of the ADTRAN website:
http://www.adtran.com/support/.

6 Third-party Interoperability

CAUTION: At this point in time, some third-party drivers and applications DO NOT yet support
Windows Server 2008 and derived platforms. When using TAPI integrations, or other integrations
requiring the use of CTI drivers, please review driver documentation for those products BEFORE
proceeding with plans to use Windows Server 2008 as the server platform for those deployments.

Please consult information provided in TNo51— UC Server Interoperable SIP Devices and Services, available online at
http://kb.adtran.com, for interoperability information related to:

e SIP telephone terminals,
e  SIP soft phones,
e SIP paging speakers, amplifiers and related devices,
e  SIP wireless terminals,
e SIP gateways and Application Layer Gateways (ALGs)
e [TSPs
Information on PBX integration and software applications is provided below in this document.

6.1 NetVanta UC Server with a PBX Integration

6.1.1  Supported Private Branch Exchanges (PBX)

NetVanta Unified Communications Server has the capability to connect to multiple traditional PBXs and IP PBXs
while simultaneously supporting SIP services . NetVanta UC Server can be deployed as a voicemail, unified
message server, database IVR platform, and fax server behind a traditional PBX while also simultaneously
supporting SIP Telephony . This provides a useful transition strategy for companies looking to migrate to
VolIP but who still want to leverage their existing infrastructure. NetVanta UC Server users who employ a
traditional PBX for telephony can still take advantage of Active Directory™ integration for user management; the
telephony features will be managed through their PBX configuration interface.

NetVanta UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 1000 and 2000
Media Gateways. The following PBXs are now supported using the Dialogic Media Gateway:

e Alcatel Omni PCX 4400 e Avaya Definity G3
e Avaya Communications Manager e Avayalegend
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e Avaya Merlin Magix e Nortel DMS 100

e Avaya Partner e Nortel Meridian 1

e  Ericsson BusinessPhone e Phillips Sopho

e Ericsson MD11o e Rolm (Siemens) 8ooo
e Intecom PointSpan M688o e Rolm (Siemens) gooo
e Mitel 3300 e Rolm (Siemens) 9751
e  Mitel SX-2000 e Siemens HiCom 150E
e  Mitel SX-200D Family e Siemens HiCom 300

e NEC NEAX2400
e Nortel CS-1000

e Nortel DMS 10

e Siemens HiPath 4000

e Toshiba CTX

For more details on specifically which PBX editions and interfaces are supported, consult the Dialogic Media

Gateway documentation available from Dialogic’s website:

http://www.dialogic.com/support/helpweb/mg/integration.htm.

NetVanta UC Server also integrates with the PBXs listed in the table below using one of the following techniques:

e Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards
e Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards

e CTllink/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards

e PBXVendor supplied Microsoft TAPI/WAVE Service Providers

PBX Vendor/Model | Minimum Technical Note Integration Type 3rd Party
Software (TN) Reference Hardware/Software
Release Number (Recommended)
Avaya 1.0 and above TNo16 Digital set emulation: Dialogic 6.0 SU 229
Communications - 7434D emulation
Manager - 8434D emulation
- 7434ND emulation
Avaya Definity 6.3 and above TNoog Analog port using mode | Dialogic 6.0 SU 229
(no CLID) codes; Mode code
option is required
Avaya 4 and above TNo1o Digital set emulation: Dialogic 6.0 SU 229
Definity/Multi- - 7434D emulation
Vantage - 8434D emulation
(with CLID) - 7434ND (7.5 and above)
Avaya IP Office 2.0 and above TNoi2 CTl link/analog port - IP 400 CTl link
using TAPI - IP 400 TAPI-WAVE
Dialogic 6.0 SU 229
Avaya Merlin 3.1and above Analog port using mode | Dialogic 6.0 SU 229
Legend codes
Avaya Merlin Magix | 2.1and above TNoo8 Analog port using mode | Magix CTl link bundle

(with CLID)

codes

Dialogic 6.0 SU 229

25



http://www.dialogic.com/support/helpweb/mg/integration.htm

NetVanta Unified Communications

PBX Vendor/Model | Minimum Technical Note Integration Type 3rd Party
Software (TN) Reference Hardware/Software
Release Number (Recommended)
Avaya Merlin Magix | 2.1and above TNoo8 CTl link/analog port Dialogic 6.0 SU 229
(no CLID) using mode codes
[TSAPI
Avaya Partner ACS 3.0 and above Analog port using mode | Dialogic 6.0 SU 229
codes
Cisco Call Manager 4.2 TNo39 Cisco-supplied Microsoft
TAPI/WAVE Service
Provider
Mitel SX200 (family) | Gioos5/LW16 TNo11 Analog port using Dialogic 6.0 SU 229
F41.0.2 enhanced in-band DTMF
tones
Mitel 3300 (IVR only) | Any version Analog port using in- Dialogic 6.0 SU 229
that requires band DTMF tones
ONS voicemail
support
Nortel Norstar 4.2 and above TNoo3 Digital set emulation: Dialogic 5.1.1 with

- M7324 set emulation

PTR.31016 **

Generic in-band

PBX dependent

Analog port using in-
band DTMF tones

Dialogic 6.0 SU 229

** NetVanta UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for
Norstar PBX’s as the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX.

6.1.2

To install Dialogic software on the new NetVanta UC Server:

New Installation of Dialogic Software

1. Install the Dialogic System Software compatible with the PBX make and model.
a. Run SETUP.EXE from Windows Explorer.

i. When prompted to select features, select Core Runtime Package; select Next.
ii. When advised that the installation will install third party software, select Yes. The installation
will detect and remove any existing Dialogic system software.
iii. The first stage of the installation will require a reboot. When prompted to restart the system,
select Yes.
2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the
"Dialogic Springware Devices section".

NOTE: If any of your cards appear to be improperly configured (i.e. caution symbol or otherwise) then you

will have to update the driver.

a. Toupdate thedriver:
i. Locate and configure the Dialogic card from Device Manager.

ii. Select Driver tab and select "Update Driver".

iii. Choose Search for suitable driver for my device (recommended) and click Next.
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iv. The driver update will locate the Dialogic Card; click Next.
b. Repeat steps ithrough iv for each Dialogic card that appears improperly installed or configured.
Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration
Manager — DCM. DCM will detect any Dialogic hardware installed on the machine hosting NetVanta UC
Server software.
a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.)
b. Fordigital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is

configured according to your integration.

c. Seethe relevant configuration guide
Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to Start
System. Itis normal to encounter the error message "Failed to set the Device Autostart setting.
Requested data not found in NCM data storage."
Proceed with NetVanta UC Server installation instructions.
Verify the Dialogic board ordering by running NetVanta UC Client as an administrator and call each port.
If the ports are not answering in the correct order, switch the Dialogic cables on the back of the machine
hosting NetVanta UC Server software.

To upgrade Dialogic software on existing NetVanta UC Server (if required)

Once you have determined that the Dialogic software version needs to be upgraded then perform the

following steps:

1.

Remove existing Dialogic system software.
a. Stop the existing NetVanta UC Server and Dialogic services
b. Launch the Microsoft® Windows Service control application (Start > Settings > Control Panel >
Administrative Tools > Services)
i. Stop the service labeled ADTRAN NetVanta UC Server Application Services and change the
service Startup type from Automatic to Manual.
ii. Stop the service labeled Dialogic System Service.
c. Remove Dialogic System Software
i. Locate the Add/Remove Programs from the Windows Control Panel. (Start > Settings > Control
Panel > Add/Remove programs)
. Select and Remove the Dialogic software.
d. Reboot the system as indicated
In rare instances you may need to run a Dialogic utility to clean up the old Dialogic Release 5.1.1
installation files, directories and registry settings. This batch file can be located in
\cleanup\dlgc rel clean.bat inthe Dialogicinstallation directory. This will be apparent if the
Dialogic DCM - configuration management application is not installed.
Install the Dialogic System Software.
a. Follow the procedure in the section above (New Installation of Dialogic) to install the required
version of Dialogic applicable to your PBX.
Launch the Microsoft® Windows Service control application (Start > Settings > Control Panel >
Administrative Tools > Services)
a. Setthe Startup type to Automatic for the service labeled ADTRAN NetVanta UC Server
Application Services.
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6.2 Software Product Interoperability

The following other software products have been tested and are known to work with NetVanta UC Server:

Vendor Interoperability Product/Service Software Version
Level
Research In Motion | Interoperable BlackBerry Enterprise Server 4.1 0r newer
(RIM) for Microsoft Exchange
BlackBerry Handheld Devices 4.2.1r1ev 163, 4.2.2 or newer
PhoneTag Interoperable PhoneTag nfa
(formerly SimulScribe)
Google Interoperable Google Mail (Gmail) n/a
using stunnel (SSL proxy) stunnel 4.24

7 Known Software Limitations

The following limitations are known in this NetVanta UC Server release:

Tracking #

ISSUE Workaround

4325

Silent Installation of NetVanta ucCompanion —Live Use Install Wizard
Attendant (installation fails using command line
with parameters: /S [v/gn)

4503

NetVanta UC Server implementations on a None. This is not a supported deployment
Microsoft Windows Small Business Server (SBS) scenario.
will not be able to view voice or fax messages from

the local machine or through the terminal services

client connected to the same Small Business

Server. The Microsoft MAPI version that is installed

with Microsoft Exchange Server does not support

the same capabilities as the MAPI driver that is

installed with Microsoft Outlook. Installing Outlook

on the SBS server will not resolve this issue, nor is it

supported by Microsoft.
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Tracking # ISSUE Workaround

4614 There is currently a known issue with the Windows = Accept the warning and continue
Installer on Windows Vista platforms. During
uninstall of NetVanta UC Server, the “User Account
Control” dialog box indicates that the publisher is
‘unidentified’. This issue is caused when the
Windows Installer caches a copy of the MSI
package in the Installer folder during the
installation process. Windows Installer removes
some data from the cached copy of the MSl in an
effort to reduce the size consumed by the copied
MSI. As a result, the embedded digital signature
becomes invalid.

5020 Call Swap on NetVanta ucCompanion — Live None
Attendant is not supported

5124 On Windows Vista, the fax printer driver will not In both cases, after installing NetVanta UC
successfully execute if NetVanta UC Client is Client it will be necessary to log out and log
installed by either the administrator or by a user back in to Windows (as the appropriate user).
that has used the “"Run as administrator” option.

Note that this scenario does not apply to a user
installing NetVanta UC Client that has elevated
their privileges to administrator to install NetVanta
UC Client.

5204 On Windows Vista, the fax printer driver will not The first time that NetVanta UC Client is run
successfully execute if NetVanta UC Client is first it must be launched from the Start Menu.
launched directly from Outlook or by running the
executable directly from the “bin” folder.

5571 Three-way conference initiators do not pass DTMF  Have the conference initiator generate the
tones generated by conference participants. DTMF tones.

5742 Windows services automatic recovery processes Ensure the recovery settings for the ADTRAN
hinder diagnosis of any startup issue and could NetVanta UC Server Application Services
result in unnecessary entries added to the system  service are set to “Take no Action” in all cases
or application event logs. (First failure, Second failure, and subsequent

failures). These settings should not be
changed.

5859 Minor non-compliance related to Request URIl in None
ACK and BYE SIP Messages under very specific
circumstances involving specialized equipment.

5862 Incorrect call status displayed on NetVanta Restart the ADTRAN NetVanta UC Server

ucCompanion — Live Attendant Ul occurs
infrequently and then usually only on low end or
overloaded systems and immediately after an
installation.

SIM service in the Services control panel.
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Tracking # ISSUE Workaround

5878 Windows XP and Windows Server 2003 system Turn off the Windows Indexing Service. See
performance — Indexing service uses large amount  the NetVanta UC Server installation manual
of page file space (larger than 1.2 GB) and CPU for instructions.
time

5966 Creating a UC user from within Active Directory, it  The administrator can explicitly set the PIN
is possible to neglect creating an associated from within the AD pages.
identity at the same time. This has the side effect
of not creating a temporary PIN for the user.

6073 Service account password is not preserved on The upgrade instructions included in this
upgrade from 4.0.x to 4.2.x if the “current account” document describe the necessary steps to
option is selected in the Select Service Account restore the service account. Please ensure
dialog box. This specifies that the currently you follow these instructions.
configured service is to be used as the service login
account. If selected, then the ADTRAN NetVanta
UC Server Application Service will fail to restart.

6256 On an upgrade from pre 4.2.1, the NetVanta The Calls menu shortcut assignments are
ucCompanion — Live Attendant “Calls” menu does  customizable, so to preserve these custom
not automatically use the new shortcuts as settings, the new shortcut mappings are not
described in the documentation. automatically registered. To manually reset

the shortcuts to the new mappings perform
the following action: Within the View menu
select Toolbars >, then Customize.... In the
Customize dialog box, select the Keyboard

tab then click the Reset All button.

6614 In some cases, caller information may not be None.
received in distributed IP Office TAPI integrations.

6797 Uninstalling NetVanta UC Server from Windows After uninstalling NetVanta UC Server,
Server 2008 does not automatically stop the manually stop the OBJECTWORLD SQL
OBJECTWORLD instance of SQL Server. Server Express service, and then manually

uninstall the OBJECTWORLD SQL Server
Express instance.

6978 After upgrade to Windows Vista Service Pack 1, UC  Reinstalling the Microsoft’s Windows Server
Server MMC plug-in is no longer available. Administration Tools will resolve the
Reinstalling NetVanta UC Client does not resolve problem.
the problem.

7074 Fax printer driver cannot send faxes when My This appears to be an issue with the
Documents folder is redirected to network share. Microsoft Universal Printer driver supplied in

Windows Vista and used by the Fax Printer
Driver. Workaround is to disable My
Documents redirection.

7376 Sending faxes to the Fax Printer Driver in A4 Print using Letter format instead.

format causes the fax document to be generated
incorrectly and the fax will fail to be sent.
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Tracking # ISSUE Workaround

7700 AMD systems running Windows Server 2003 or Follow instructions in Microsoft KB article
Windows XP may experience choppy or corrupt 895980:
audio with some phones. http://support.microsoft.com/kb/895980

8149 Active Message Delivery may fail when all ports on  Increase the number of ports to improve port
an Avaya IP Office are busy. availability.

8282 On Windows XP, the service account used for the Use Windows Server-based platforms instead
Application Services may spontaneously become of Windows XP. Additional instructions have
lost or invalid. This can occur when the system is been added to upgrade procedure to
restarted, the ADTRAN NetVanta UC Server mitigate the 1920 problem during upgrade
Application Services service is restarted, or the caused by this issue.

NetVanta UC Server software is upgraded (causing
a 1920 error).

8374 snom phones do not register on networks with Enable fast spanning tree or disable spanning
spanning tree enabled. Consult snom support tree on the network. Consult snom support
material for more details. material for more details.

8621 Deployment of NetVanta UC Client components None at this time.
using Active Directory GPO deployment takes
roughly 1 hour per client system.

8659 No click-to-dial context menu is provided on Upgrade to Outlook 2007.

Outlook 2003 email messages.
8660 In medium to large size Active Directory Ensure Active Directory Global Catalog

installations (>1000 users), or where users do not
have a Active Directory Global Catalog Server on
the local LAN (e.g. VPN, remote site), click-to-dial
phone number look up may be slow and causes
delays when displaying contact and email message
context menus in Outlook.

Server is located at each site.

No other workarounds available at this time.
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